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1-1 AEC SETUP - DISPLAY

1AEC Setup Access

AEC Setup Toolbar
How do I get this toolbar?
You can also acquire access to these commands form the Format 
pull-down menu - see illustration below.  This toolbar is an optional 
tool and is not needed to use this guide but may help.

AEC Setup Pull-down menus

The Display System  in ADT is one of the most difficult subjects to 
comprehend and master.  It is also the most important tool and that 
is why I have chosen to make this subject the first one to be 
discussed in this guide.  My suggestion is that you to read through 
Part 1, take in as much as you can and then refer back to this 
material as needed while learning about the Objects. Throughout 
this guide you will find links back to this material as it applies to 
object behavior and appearance.  Generally speaking, once you 
understand the Layer and Display system for one object, you will 
understand it for all objects.

Illustrated to the right I show the Format pull-down menu  with red 
dots next to the main topics that will be discussed below.  Though 
the Display Manager is the primary tool for Display Management, I 
have also included the topic of Drawing Setup , Style 
Management, Material Definitions  and Classification 
Definitions  since they all affect the organization and appearance of 
objects in your drawings.

For users who are not familiar with the concept or technique of 
working with objects ( not blocks but "smart" objects ), there are 
two fundamental concepts that you will need to recognize to avoid 
getting overwhelmed and frustrated when you don't get the results 
you want.  The first concept is that most of these block-like objects 
have built-in behavioral characteristics referred to as reactors and 
the second concept is that these objects are all controlled through a 
centralized display system.

This means that if an object does not appear the way you expect or 
want, either the software cannot produce what you want or you will 
need to investigate the settings that affect the reaction or the 
display.  In the case of a Wall meeting another Wall, for example, 
you will find that there are Properties that affect the way that wall 
joins with another wall and there are Properties that affect how the 
wall appears in general and even at the point of intersection.
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Architectural Desktop 2004 reduced the overall number of template files by a 
dramatic factor and basically now only offers two to choose from: 
"Architectural Building Model and View .. ." and " Architectural Sheet ..."  
The other template files are simply versions of the same configuration for 
such things as Pen Configuration and Metric.  The " acad.dwt" that is listed 
under the default Template folder for ADT is not really the same old 
"acad.dwt" that you would use in AutoCAD so don't mix the two up.  Despite 
the other folders within the default Template folder, only the "AutoCAD 
Templates" actually offers other .dwt files.  You can use the AutoCAD 
template files if you don't want a template file with any ADT configuration 
data in it ( this might be for a drawing that you won't be using ADT for at all 

).  The remaining folders contain actual 
drawing files that were meant as 
examples for project work ( hence the 
listing under Templates ). One of your 
first tasks with ADT should be to 
consider how you will format and 
configure your own Template File for use 
in your office but if you haven't already 
started that task in a previous release of 
ADT, the " Architectural Building Model 
and View (...).dwt " is a good place to 
start with and to follow along in this 

guide.

The "Architectural Building Model and View (...).dwt" template files offer the 
list of Display Configurations illustrated to the left.

Templates Files and Display Configurations

Format> Drawing Setup...Menu

AecDwgSetupKeyboard

Architectural Desktop 4 Deployment eGuide - for 
information on templates and how to configure them for 
your office

Links

Generally, Architectural Desktop has a set of default configurations 
that will allow you to begin drawing immediately.   The problem with 
the default configurations is that they are the "defaults" and often 
produce results that are very distant from what you and your office 
wants.  These default configurations reside within template files 
that you use when you start a new drawing file.  If you don't use one 
of the template files that come with ADT or open older files that 
predate ADT, you will not get these configurations and that may end 
up causing you some frustration.  The good news is that I will be 
discussing, throughout this guide, how you can import ADT data 
from other files so you can make any file perform like one of the 
template files.

One of the most important configurations that come in ADT 
template files are the ones that control the display of objects; these 
are refereed to as Display Configurations  and are bound in a trio 
of configurations that include Display Representation Sets and 
Display Representations ( by Object ).  These Display 
Configurations are used to change how objects look in a drawing 
when you want to see it, for example, as a typical Floor Plan vs. a 
typical Reflected Ceiling Plan. The control or switch for this Display 
Change resides on the Drawing Window Status Bar  near the lower 
right corner of your ADT Application Window - look for the words: 
"Display Configuration:"

By picking on the black down arrow or the current display 
configuration name, you should find that you invoke a pop-up menu 
that displays one or more Display Configurations to choose from.  ( 
note: if you only find "Standard", then you are most likely in an older 
file that predates ADT ).

Using the Start from Scratch 
option will yield Display 
Configurations for High Detail , 
Low Detail , Medium  Detail, 
Reflected and Standard.  Starting 
a drawing from the old ACAD.dwt 
template file will only provide you 
with the Standard Display 

Configuration and that's it.

2-1 AEC SETUP - DISPLAY

2Drawing Setup Dialog Boxes
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Drawing Setup - Units Tab

Format> Drawing Setup...Menu

AecDwgSetupKeyboard

As with any AutoCAD file, Architectural Desktop files need to be 
Set Up in such a way that the Units, Scale and Layering are set to 
match what you need.  Unlike AutoCAD, however, Architectural 
Desktop actually has a Scale that affects the objects in the file and 
objects being inserted so make sure to pay special attention to the 
Scale settings.  Architectural Desktop also uses automatic layer 
keying so objects are placed on the right layers as you draw or 
insert them.  Though the Scale and the Layer Keying settings can 
be changed later in a drawing, it is not a lot of fun to deal with so 
you should get these settings right before starting a drawing.

The Drawing Setup dialogue box is ADT's central control for 
configuring the current drawing's Units of measure, Scale of 
Annotation, Layering Standard and Display  of Objects' defaults  - 
see illustration to the right.  AutoCAD has a similar dialog box, 
activated with the DDUNITS command and both dialog boxes 
affect the same variables but it is best to use the AecDwgSetup 
command.

Units Tab -  on this tab you will be able to set the Primary Unit 
measure, the Unit display Type and the round off precision for the 
Type.  Inches, for example, can be displayed as a Decimal Type 
with a round off Precision of 1/100 inch.  Always set the Precision 
to something greater than you expect to worry about.  For Area and 
Volume  settings, use settings that you actually want to display in 
tags and tables.  For Angle settings, the general rule of thumb in 
AutoCAD has been to measure this in Degrees where the counter 
clockwise direction is positive ( don't check Clockwise to stay with 
the industry standard ).  For Scale Objects Inserted From Other 
Drawings, you will most likely  want this feature checked on 
because it will automatically convert objects from files created in 
other Drawing Units.  If you decided to do a drawing in Units of 
Feet, for example, and copied this object into another file setup for 
Units of Inches, the object will be scaled up appropriately.  If you 
don't use this scale option, an object drawn based upon a Unit of 
Feet will be translated to Units of Inches without conversion and 
thus .5 feet would become .5 inches ( not good ).

Drawing Setup - Scale Tab

Scale settings in ADT actually affect the objects you use in a 
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drawing, particularly objects that have annotation elements within 
them such as Section Bubbles, Object Tags and Schedules.  

Drawing Scale - this value should be set correctly prior to doing 
any annotation work like inserting labels, tags, schedules or 
dimensions.  Changing the Drawing Scale after objects, such as 
dimensions, have been placed does not change the objects so this 
is very similar to working in AutoCAD but it also allows you to 
annotate at different scales while in the same drawing.  For Other... 
scales, think in terms of ratios such as 1:48 for 1/4" = 1'-0" and 
thus you can create a scale of something like 1:600 for 1"= 50'-0"; 
i.e., you select the Other... option and type 600 in the Custom 
Scales value field.

Automatically Create Dimscale Override  - this checkbox option 
was never an option in any previous releases of ADT and it drove 
ADT users crazy because if the Dimscale did not match the 
Drawing Scale, ADT would automatically change the scale with an 
Override Dimension Style.  If you are diligent about changing your 
Dimension Style DimScale  Value then this option should not be 
necessary for you and it will allow you to be more creative.  Note: 
this only affects AutoCAD Dimensions and not AecDimensions.

Annotation Plot Size - this value field allows you to control the 
size of text based objects such as bubbles and tags; i.e, because 
the text is bigger so is the object that contains it.  This means that 
you can manage a drawing at one scale while placing annotation 
objects for larger or smaller scales.  Traditionally, 1/8" has been a 
standard among Imperial Unit drafters but most of ADT's 
annotation based objects come out a bit large at that scale so many 
are now using the value of 3/32 inches.

Drawing Setup - Layering Tab

Part 2 - Layer Management - for more information on the 
automatic layering system in ADT.

Links

Layering in ADT is a very powerful feature that can be customized 
to meet almost any office's standards; including naming, linetype, 
lineweight and coloring options.  The only significant drawback to 
this system, in my opinion, is that it does not affect non-ADT 
objects so you cannot count on this feature for placing old 
AutoCAD blocks, AutoCAD Dimensions, AutoCAD Text or other 
AutoCAD based objects on the right layers. In other words, if you 
have to draw using AutoCAD based objects you have to do the 
layering yourself.

Layer Standards/Key File to Auto-Import - use the " ..." button to 
access any drawing file that contains a Layer Standard and Layer 
Key Style that you want to make current.  The default Layer 
Standards file resides within the Layers folder of the Autodesk 
Architectural Desktop 2004 Folder - see Default Folder Structure  for 
more.  The "AecLayerStd.dwg" file, for example, contains the 
Layer Key Styles that control such things as names of the layers, 
their lineweights, linetypes and so forth.

Layer Key Style - on this drop-down list you should find any and all 
of the Layer Key Styles residing within the Layer Standards drawing 
file set in the field above this drop-down list.  I have yet to come 
across one office that is content with the default Layer Keys so you 
too will probably want your own settings for this feature and it is 
fairly easy to do - see Part 2 - Layer Management.

Always import Layer Key Style when first used in drawing  - this 
checkbox option, introduced in ADT 4, provides CAD managers 
with the option to insure that a regularly changing Layer Key Style is 
always being imported into new drawings.  This is a great option 
and only under unusual circumstances would you not want this 
feature; cases, for example, where you use different Layer Key 
Styles that have the same name or cases where you want the Layer 
Key Style in template files to control the keying.
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Save As Default - this option is available for all of the Drawing 
Setup tabs but I have drawn a red rectangle around it here to 
remind you how important this setting is with respect the the Layer 
Standards.

Drawing Setup - Display Tab

The Display tab of the Drawing Setup dialog box offers a somewhat 
archaic option for accessing each of the object families in ADT and 
their corresponding default Display Representations.  I call this 
"archaic" because the better option for accessing this information is 
through the Display Manager ( discussed below ).

Object Type - this list offers access to all of the unique objects 
that are specific to ADT and you can actually count them.

Display Representations - this list shows all of the various 
Representations that are available, by default, for each object 
selected under the Object Type list.  Though the 2D 
Section/Elevation object, illustrated to the right,  may only have one 
Display Representation by default, a Door object has fourteen.  
This topic will be discussed in greater detail below and throughout 
this guide but in short, Display Representations are exactly what 
the term connotes: appearance.  If you think about how you might 
want a Door to look in a typical floor plan at 1:48, for example, think 
about how it should look at 1:196 or at 1:12; and think about how it 
should look in an Elevation or 3D Model and you get the idea.

Drawing Default Display Configuration  - this drop-down list 
offers access to the same list of Display Configurations that you 
will find on the Drawing Status Bar and in the Display Manager 
Window.  All users should know that these exist, how to set 
different ones and eventually how to alter them to produce custom 
results.  Medium Detail is the default Display Configuration when 
ADT is installed.

When used as an Xref Overlay use Display Configurations from 
this drawing only  - this checkbox option, when checked, allows 
this file to control its own Display Configuration independently in 
another other file where it is being Xref'd in.  In other words, as a 
source Xref file, it will have control over its own Display 
Configuration regardless of the Display Configuration used in any 
target files.  I do not recommend using this as a default option but it 
can be used to create some interesting results; e.g., a second floor 
in High Detail with an Xref of a 1st Floor in Screened Low Detail 
and an underlay.  You see, what it achieves is the ability to have 
different Display Configurations active at the same time.   This 
setting can be activated and deactivated at any time on a drawing 
in a project.

3-1 AEC SETUP - DISPLAY

3Setting Displays
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There are two primary places where Display Controls are managed: one is via 
the Display Manager ( illustrated upper right ) and the other is through Object 
Styles ( discussed later, below ).

When you switch Display Configurations, you are are actually triggering a 
whole Display Representation Set of Object Representations; i.e., a change 
from High Detail to Low Detail actually goes through a list of all the objects 
and displays them as per how they are set with respect to those two 
Representations ( in the default case, as defined by the manufacturer of this 
software ).

Set Current Display Configuration

Format> Display Manager... Left-Click over a 
Configuration, Set to Current Viewport

Menu

Left-click over triangleStatus 
Bar

AecDisplayManagerConfigsSelectionKeyboard

Templates Files and Display Configurations  - for more 
on how to switch between these configurations.

Links

ADT has the ability to change the display of numerous objects so 
you don't have to rely on Layer controls, Xref and Block swapping or 
any of the numerous other odd techniques AutoCAD users have 
developed over the years.  This means, for example, that you can 
go from a High Detail Display Representation of a Wall or Door to a 
Low Detail Reflected Ceiling Display Representation at the click of 
a mouse button.

Illustrated to the right I show the primary Display Configuration 
pop-menu and how you access it ( lower right corner of drawing 
window area on a new bar called the Drawing Window Status Bar ).  
Also illustrated to the right, I show the source of that pop-up menu 
so you won't be confused about where it comes from and how you 
can Add or Delete Display Configurations ( Display Manager 
Window activated by typing "AecDisplayManager" ).

Changing Current Display Configurations

Automated Display System  - for another discussion of 
this topic.

Links

I illustrated to the right are examples of how the Display 
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Configurations  can be 
used to change the 
appearance of some basic 
ADT objects.   Illustrated 
below, left, I show an 
example of the information 
that resides within an ADT 
object ( a Door in this 
example ) that controls how 
it appears or displays when 
you change the Display 
Configurations.  At the heart 
of the display system are 
the object representations 
that control how object 
families ( and sometimes 
individual objects of a 
family) appear when the 
Display Configurations are 
changed.  In the illustration 
to the left I show some of 
the hard coded Display 
Components  ( think of 
these as internal layers ) for 
the Door Family.  The 
number and type of Display 

Components will vary depending on the object and representation

To bring a collection of Object Display Representations  together, 
ADT uses a Display Representation Set .  The Display 
Representation Set merely associates the various display 
representations ( such as High Detail ) of all the objects with a 
unique name.  The primary purpose for this Set is so you can create 
custom combinations of your own choice; such as a Reflected Set 
that shows Doors and Windows in Low Detail, for example.  

Because ADT uses 3D objects and because architects tend to 
display objects differently in Plan View than Elevation View, for 
example, ADT uses Display Configurations  ( this is what you use 
to switch displays ).  Display Configurations associate Display 
Representation Sets according to Views thus allowing for 
automatic Display Representation Set changes when a user 
switches from Top View to Front View, for example.  

Changing Current Display Configurations in Viewports

When using Layouts and Viewports in ADT, you can either change 
the Display Configuration by choosing one while in a Viewport or by 
selecting a Viewport frame when not in any Viewports.  If you are 
not in a Viewport and you attempt to change the Display 
Configuration, notice that a prompt will appear on the command line 
requesting that you select a Viewport Frame to apply this change 
to.  If you do not select a Viewport Frame but hit the Enter Key 
instead, you can apply a Display Configuration to a Layout Space.

The use of different Display Configurations for different Viewports 
provides a fairly efficient way to create such plans as that illustrated 
to the right where I have a proposed remodel displayed as a typical 
Plan configuration next to the same proposed remodel displayed as 
a typical Reflected configuration

What I illustrate to the right exemplifies the ultimate goal of 
producing architectural designs as Single Building Models ( SBM ) 
but I have found that the practice of SBM tends to be the stuff 
more of myth than reality.  It is true that in many cases this concept 
can and has been applied rather successfully but the cases tend to 
be rather unique.  One case, for example, is that the job is small 
and another case is that the job is being managed and produced by 
one individual on one machine.  The best answer to how far you go 
with the SBM concept is a matter of how drawings are managed 
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and processed in your office.  I also like to remind AutoCAD users 
about the years they have spent perfecting organizational 
processes; there is no reason why most of them cannot continue to 
be applied to the use of ADT.  

4-1 AEC SETUP - DISPLAY

4Display Management

When you highlight a drawing file in the Display Manager Window, it will 
display the drawing's Properties - as illustrated above right.  You can access 
the Drawing Properties...  from the File pull-down menu or type 
"DWGPROPS "

Display Manager

Format> Display Manager...Menu

DisplayManagerKeyboard

When you change the Display Configuration in a drawing, as 
discussed above, you are selecting a name off a pop-up menu that 
is actually stored within another tool called the Display Manager.  
The Display Manager Window, illustrated to the right, has three 
hierarchical folders that all store levels of display information about 
the ADT objects in your current drawing file.

Configurations folder  - stores a list of display configurations that 
you can select from in a drawing file.  These choices are available 
via the "AecDisplayManagerConfigsSelection" command or via the 
Display Configurations pop-up menu on the Drawing Window Status 
Bar.  Technically, these configurations orient Display 
Representation Sets so a drawing may change automatically 
depending upon the viewing direction.  Display Configurations also 
provide Global Cut Plane Settings for objects that extend beyond a 
typical single story.

Sets folder - stores a list of names that describe a whole set of 
object representations.  The function, therefore, of a Display 
Representation Set is to combine or group individual display 
representations of object families; i.e., you could, for example,  
group Doors that display in Reflected mode, Windows that display 
at High Detail,  Walls that display in Low Detail and so on for each 
object family.  Display Representation Sets also provide 
Classification Show/Hide  control and some interesting settings 
for Live Sections.

Representation by Object folder  - stores a list of all the ADT 
object families and provides the deepest level of display control 
over individual object families.  At this level, individual object 
families will have an internal list of display representations ranging 
from High Detail to Diagnostic and Reflected.  Some objects have 
more display representations than others depending upon their 
function in drawings but most allow you to add your own should 
there be a need for custom representations.  You cannot create 
unique representations but you can copy existing ones and modify 
their names and settings.

When Which "Object Hows" are DisplayedConfigurations
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Display Configuration - Association with Display 
Representation Set

Display 
Configurations 
associate  Display 
Representation Sets 

with View Directions  so you may see one Display Representation 
Set when you view your drawing from the Top but a different Display 
Representation Set when you view your drawing from a Front View ( 
elevation ).   One might argue that this seems redundant and that 
the full Model Representation should be fine regardless of View 
Direction but the problem with the full Model Representation is that 
it carries too much graphical information.  By using Display 
Configurations to automatically switch Sets of Object 
Representations, graphical detail can be adjusted for the purpose of 
the View Direction.

In the Display Manager Window , illustrated to the right, I show 
how the default Low Detail  Configuration stores four Display 
Representation Sets from the Sets folder.  Also illustrated to the 
right, you should be able to see that  View Directions  have been 
assigned to each of the four Display Representation Sets: Top = 
Plan Low Detail, Bottom = Plan Diagnostic, Left-Right-Front-Back 
= Section_Elev and Default ( any other view direction ) = Model 
Low Detail.  

These View Direction associations change the Display 
Representation Set when you change the View Direction using the 
View buttons.  Different Display Configurations can use different 
Display Representation Sets and different View Direction 
associations so the results of changing View Directions depend 
upon the current Display Configuration.

Display Configuration - View Direction  

For each of the six Views listed under the Configuration tab, you 
can associate any one of the Display Representation Sets.  This 
means that you could, for example, create unusual associations 
like Front = Plan; though this would not really make sense it 
demonstrates how powerful the system can be.

The seventh View Direction , titled Default, is typically used for 
non-orthogonal view directions and would thus include any of the 
Isometric Views and any 3D Views set with the 3D Orbit tool.  With 
the exception of the Diagnostic Display Configuration, most of the 
default Display Configurations use Model or a permutation of the 
Model Display Representation Sets ( like Model High Detail ).   Be 
sure to keep this setting in mind the next time you have a desire to 
see your plan as a flat 2D image in Isometric View; i.e., associate 
the Default View Direction with something like the Plan Display 
Representation Set and you will not see a 3D building in any of the 
non-orthogonal views.

Display Configuration - Override View Direction

As an alternate solution for controlling the association between 
View Direction and one Display Representation Set, you can use 
the Override View Direction checkbox.  When you check the 
Override View Direction , the Display Representation Set  
associated with the  Default View Direction  becomes the only 
Display Representation Set used no matter what direction the 
model is viewed from.

Note:
The Fixed View Direction is enigmatic to me at the time of this 
writing because I could not create one example where it actually 
changed anything and it is my belief that this override is really about 
using one Display Representation Set for all cases no matter what 
the View Direction is.
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Display Configuration - Cut Plane

On the Cut Plane tab for a specific Display Configuration, you can 
manually set the display cut range for all of the objects in the 
current drawing or use the Calculate button to base the range on 
settings on the Project Navigator .   

In ADT 4 most objects have been set, by default, to allow the new 
Cut Plane Display Configuration values to govern the cut plane 
height.  Some Objects, such as those belonging to the Door and 
Window Object Families, are controlled by the objects they are 
Anchored to; this is referred to as the "Container Object" and is 
typically a Wall.  Doors and Windows do not have their own Cut 
Plane values but some objects, like Stairs and Slabs do.  These 
objects typically have an option for manual control of Cut Plane 
Height rather than using the more global cut plan height as set by 
the current Display Configuration.  To access the object specific 
cut plane heights, see the object Display Representations.

Illustrated to the right I show the three basic range controls as 
offered on the Cut Plane tab of the current Display Configuration.  
In addition to the Display Above Range, Cut Height and Display 
Below Range, you can use the Calculate button to automatically 
generate the Cut Plane ranges according to the floor Levels 
settings on the Project Navigator for the Current Project.  If you are 
not using the Project Management tools in ADT you will not be able 
to take advantage of this feature but by setting similar values 
manually, you will get the same results ( so fear not ).

Display Above Range  - the height at which the lines of things 
Above will be cut off; i.e., items above this height will not be 
displayed even as dashed lines.

Cut Height  - the height as which the Z-axis cut plane for plans is 
set.  Typically, this value is right through all Doors and Windows in 
Floor Plans but above Doors and Windows for Reflected Ceiling 
Plans.

Display Below Range  - the height at which the lines of things 
Below will be cut off; i.e., items below this height will not be 
displayed even as dashed lines.

Which "Object Hows" are DisplayedSets
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Display Representation Sets 

Next in the hierarchy below Display Configurations are the Display 
Representation Sets.  These Sets can be accessed from the 
individual Configurations or by selecting individual Display 
Representation Set names under the Sets folder.   To access the 
Sets from the Configurations, expand a Configuration by picking on 
the plus symbol in the left-pane of the Display Manager Window to 
reveal the various View Directions that have associations.  Select 
one of these View Directions in the left-pane and you will see the 
very same Display Representation Control layout as that accessed 
directly through the Sets folder.

Display Representation Sets are actually just what the name 
implies: sets of display representations.  Since ADT has numerous 
object families ranging from Grids to Doors, each object family has 
one or more display representations that can be grouped in a single 
Display Representation Set.  Though you might think that every 
object should always be displayed in Plan for a Plan View, there are 
cases where you might want to show some objects in Plan View 
and others in Reflected View, for example - think of a lighting plan 
with furniture objects.  Since ADT offers Display Representations 
for levels of detail, you can also create Display Representation 
Sets that show some objects in low detail while others are in High 
Detail.

Display Representation Control tab

Illustrated to the right I show a portion of what the " Plan Low 
Detail" Display Representation Set looks like and how most 
Objects have and use the "Plan Low Detail" Display Representation 
for this set.  Notice, however, that in this Display Representation 
Set ( a default in ADT's template files ), that the Window Object 
Family uses the "Nominal" Display Representation instead of the 
"Plan Low Detail".

If you change this setting, you will find that the "Plan Low Detail" 
Display Representation for Windows removes the glazing line that 
most prefer to show in typical construction documents and that is 
why the "Nominal" Display Representation is used instead.  You 
can, of course, change any of this by going further down into the 
Display System and working at the object level ( see below ).
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Display Representation Sets - Display Options

Live Sections - for more information on the Live 
Sections and Materials topic.

Links

On the Display Options tab  for individual Display Representation 
Sets, you can control the visibility of objects by their 
Classifications.  The visibility control is either on or off as set by 
the Show or Hide Filter setting.  

Object Classifications occur at the Object Style Level and you must 
create a Classification Definition Style before applying any 
Classification categories to object styles.

When a Classification Filter is set to Hide, object Styles associated 
with this Classification Category will disappear as if turned off.  
Since this setting occurs at the Display Representation Set, the 
results of these settings will depend upon the Display Configuration 
that uses this Set.

Live Sections and Materials

Section AEC Objects by Display Range defined in Display 
Configuration - use this option to include the Display Configuration 
Cut Plane Range as part of the active Live Section.  See the Cut 
Plane tab for the current Display Configuration.  This means that 
you can cut horizontally even if your Live Section is only vertical.

Show Materials where Display Range Intersects AEC Objects - 
this option requires the option listed above to be checked.  If on ( 
checked ) a section outline will be displayed at the point where the 
Cut Plane cuts horizontally.  This is similar to what you see when 
cutting normal vertical sections.   The control for this Display 
feature can be found on the Object Style Properties dialog box, 
under Materials - Shrinkwrap.  See the Sectioned Boundary Display 
Property to change the Color, Linetype, etc.

Hide Sectioned Body Component - use this option to turn on or 
off (hide) the objects that are outside of a live section.  

Hide Surface Hatching - use this option to turn on or off surface 
Surface Hatches on Faces of objects.  If you use Materials for 
Rendering this may not be something you will want on but if you 
want hatch patterns like those you see on your Elevations, this is 
the place to check them on for Live Sections.

How Objects are DisplayedRepresentations by Object
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Display Representations by Object

At the lowest level in the Display Hierarchy, are the Display 
Representations for individual Object Families .  Though these 
are at the lowest level in the Display Manager Hierarchy, they are 
the most important feature of the whole display system because 
this is where the actual display settings are managed.  In other 
words, Display Configurations and Display Representation Sets 
generally don't affect the display of the objects but are more like 
organizing tools for all of the object display options.

Illustrated to the right I show, in the right pane of the Display 
Manager Window, how you can get a map that correlates all of the 
object families with the various Display Representations that may 
or may not apply to those objects.  By double-picking on the 
Properties icon in a particular cell, you will be able to edit that 
display representation but I find that this type of work is a lot easier 
to manage by first selecting the object family name under the 
Representation by Object folder in the left pane ( see discussion 
below ).

Display Representations by Object - Relationship to Sets

As discussed above under the topic of Display Representation 
Sets, each individual Object Family has a set of default Display 
Representations that are associated with one or more Display 
Representation Sets as one of many in a group for all other Object 
Families.

In the case of a Door Object Family, for example ( see illustration, 
right ), the default list of Display Representations holds about 
fourteen different representations.  Some of these are actually just 
permutations or copies of the primary set and you can distinguish 
these by the little arrow on the properties icon.   This arrow 
symbolizes that the representation is a pointer to a parent 
representation (if the name is not indicative of this then it is really 
difficult to figure out which one is the parent - keep this in mind 
when creating your own).

Depending upon the type of object and its general use in 
architectural design and presentation, the number of Display 
Representations will vary.   One of the most common is the " Plan" 
Display Representation  where you will find Properties that relate 
to all of the linework you might want to control for the "Plan" look of 
that Object Family.  If you find the logic of this subject a little 
confusing, think in terms of AutoCAD-like Blocks and Layers.  
Now, imagine making a block of a Door with Layer Names for all of 
the parts that you think you might want to control for the look of that 
door in Plan View.  Then, imagine adding another Block to the 
same Door Block but this one will be used for how the Door will 
look in Elevation; add all of the linework and Layers for how you 
might want to control that look.   ADT objects are basically like 
sophisticated Blocks and all of the Layers are embedded within 
them as something called "Component Layers".  These Display 
Representations are your controls for the different Views: Plan, 
Elevation, Reflected, etc.

Illustrated to the right I show the correlation between one Display 
Representation ( Plan Low Detail ) of one Object Family ( Door ) 
and one Display Representation Set  ( Plan Low Detail ) that this 
representation has been grouped under.

Display Representations by Object - Display Properties - Layer/ 
Color/ Linetype Tab

Object Style Display Properties  - for the continuation of 
this topic as discussed from the object point of view Keyboard
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rather than the Display Manager's point of view.

For each Display Representation of an Object Family, you can 
double-pick on the Properties icon to access the actual Display 
Properties of that Object Family for that particular representation ( 
like Plan ).  Once you get this deep within the whole display 
system, you are actually affecting how and what to display.  Notice 
that the list of "Display Components" on the Layer/Color/Linetype 
tab of the Display Properties dialog box is different for different 
Display Representations.  The Display Components are also very 
different from Object Family to Object Family since different objects 
have different pieces ( components ) that explain how they are put 
together and what pieces you can control.

The Layer/Color/Linetype tab  on the Display Properties dialog 
box contains what can essentially be described as internal object 
layers.  By placing these "layers" inside the object display 
representations, you don't have to work with hundreds of physical 
layers but basically only one physical layer for each object family.  
Depending upon the Display Representation and the Object Family, 
you may find different tabs on the Display Properties dialog that 
provide additional display options ranging from the ability to Add 
Custom Blocks to Adding Parametric Muntins ( usually the greatest 
offerings are under the Model Display Representations ).

If you want to create your own Display Representation for an ADT 
Object, highlight a pre-defined one that offers the options you want 
and then pick on the New button.  Notice that if you do not highlight 
a Display Representation, you will not be able to create a new one.  
Also, creating new Display Representations is really more like 
creating a shortcut or pointer to a pre-defined one; where you make 
unique settings.

Display Representations by Object - Display Properties - Other 
Tab

For most of the Object Families in ADT, the Display Properties 
dialog for various Display Representations offer a Tab called 
"Other" that has unique options and settings for custom controls.

Illustrated to the right I show the "Other" tab for the Plan Display 
Representation of the Door Family.  On this tab, as with numerous 
others, you will find the option to Add...  custom Blocks for such 
things as Door Knobs, Handles, decorative elements and so forth.  

In addition to the ability to Add... custom blocks you should also 
find other options and settings that are unique to each object type 
and the current Display Representation Properties.  There are far 
too many options to list here so you might look to the different parts 
of this guide or simply investigate on your own because even 
though this guide covers all of the object families it does not cover 
all of the possible options on every single "Other" tab.

Note:
Notice the Respect Cut Plane of Container Object when Anchored 
checkbox.  This option, checked by default, defers the cutting plane 
height to the Wall that the Door is Anchored within.  
Consequentially, the Wall, by default, defers the Cut Plane height 
to the current Display Configuration which , in turn, may use the 
current Project Level Settings for this calculation.

5-1 AEC SETUP - DISPLAY

5Object Style Management Overview
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Style Manager

Format> Style Manager...Menu

AecStyleManagerKeyboard

The Style Manager Window , illustrated to the right, provides 
access and control over individual objects within an Object Family.  
This differs quite a bit from the Display Manager which manages 
the display of all objects while the Style Manager manages the 
physical dimensions and display characteristics of individual 
objects within Families .  Where the Display Manager leaves off 
on basic component settings, the Style Manager picks up with 
options for physical dimensions, schedule data and unique display 
characteristics that may deviate from the default ones as set by the 
Display Manager.

Through the Style Manager, for example, you can Import, Create 
New, Modify or Purge individual objects such as Double Doors, 
Casement Windows, Floor Slabs, Wood Housed Stairs, Metal 
Railings and so forth.

Illustrated to the right I show the typical left and right panes 
displayed when the Style Manger Window is first opened.  In the left 
pane you should always see the name of the current drawing file 
and any other drawing files that may currently be open.  In addition 
to these drawing files, you should also see any files that you have 
opened previously within the Style Manager to access other object 
styles ( notice I show the "Wall Styles - Stud (Imperial).dwg" as an 
example of this ).

Every drawing file will display three object folders that are organized 
by function to help you go through the list more expediently.  These 
three folder categories are "Architectural Objects", 
"Documentation Objects" and "Multi-Purpose Objects".  

Style Manager - Objects

Style Manager Objects - to see the full list of all objectsLinks

Illustrated to the right I show the expanded view for the Door 
Styles under the Architectural Objects folder and how the right 
and left pane will display the same list of object styles.  The only 
significant difference between accessing the objects in one pane 
over the other is that the right pane allows for multiple selections in 
Explorer-like fashion and this can be rather handy when dragging a 
bunch of styles from one file into another.

Within one object family, all of the Style Property options are always 
the same but how you adjust these properties will not only make 
them unique but in some cases will also limit or open other property 
options ( Muntins in Doors, for example, are only available on 
Doors with openings in them ).  Many of the object Style Properties 
also offer an array of options that control how they look and function 
so the variation can be extremely broad; in some cases, unlimited 
possibilities.
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Filter - is what happens automatically when you use the Style button on any 
object toolbar: it's filtered for that object style only, leaving the other object 
styles closed and un-viewable until you turn off the filter.

List - this is just like the list options for Explorer.  Large icons and Details are 
probably the best options - too bad the large icons don't actually show an 
image of what the object style looks like, that would be really cool.

Style Manager Toolbar

Remember that you also have right-click menus for tasks such as 
New, Copy and Paste but also Send... for sending a Style via 
e-mail to someone else.

New Drawing  - actually Creates a New Drawing just like you would 
create a new drawing in ADT.  The concept is based on the way 
Styles work in ADT: if you want a set of unique styles, they can be 
saved in a drawing file.  In fact, that is how styles are managed; in 
drawing files.

Open Drawing - allows you to either open a Style drawing file or 
any drawing that contains styles that you might want access to.   
This is how you access and import Styles from one file to another.

Copy and Paste  - work like any copy and past in that you find a 
style you want from one drawing and paste it another.  As I 
understand it, the process actually uses AutoCAD's block process 
to transfer the data.

Edit - allows you to change the data within a style.  Double-clicking 
on a style does the same thing.

Create a New Style  - allows you to start with a blank of default 
settings for a particular Object Style; i.e., you can't create a 
completely original style nor a style for a non-existing object.  Often 
it is far faster and easier to Copy, Paste and Edit.

Set From - allows you to define elements or components of a Style 
by selecting an object on the screen.  A Wall Endcap Style, for 
example, can be defined by using Set From to select a polyline 
object as the shape.   Not all Styles can use this option even 
though it seems available ( this is a reported defect in the program 
).

Purge Style - allows you to remove unused styles in a drawing file.

Toggle View  - sorts the Tree View (left column) by Drawing or by 
Style (see Status bar for which type you have).  This actually has 
three features depending on what you have selected in the left 
pane.  If you have a style selected and toggle, you will either see a 
list of styles or a list of drawings and the current style types - this is 
really useful if you want to go back and forth between drawings and 
work with the same Style types (like Doors).  If you select a drawing 
file and toggle, you should see a table of drawing files in the right 
pane; now pick a Style type and the right pane should display a 
table of that particular Style type for all currently open drawings.  
This is really useful when doing comparisons between files.

Style Manager - Other Styles
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Hey, where did all of my stuff go?  - for the path to the 
Imperial and Metric Object Styles Folders.

Links

In the world of ADT, every drawing is basically a source of data for 
every other drawing so you can actually use the Open Drawing 
option from the Style Manager Window  to Open any drawing file  
and poke around inside its Style Library to Import them.

In the illustration to the right I show that I have located the Imperial 
Folder for all of the Object Styles in ADT and Opened the " Door 
Styles (Imperial).dwg" file.  On the Style Manager Window I show 
what this file looks like when Opened and how I have expanded the 
Door Styles category to reveal all of the Door Styles in the right 
pane.  In addition, I show that I have selected several Door Styles  
by using the Ctrl key and am Dragging  them into the Door Styles 
category of the current drawing file that I am working in.

By using this technique, you can not only access all of the Imperial 
or Metric Object Styles that come with ADT but you can also create 
and access your own custom Library Files for objects.  You should 
also know that when you use the Tool Palettes, this is exactly what 
they are doing for you: accessing one of these files and importing a 
specific object style.

Illustrate to the left I show a 
procedure that I recommend for the 
process of creating your own Object 
Styles: Copy and Existing one, 
Rename it and then Edit... it.  By 
using this technique as opposed to 
creating one from Scratch, you save 
time by not having to change every 
single Style Property unless you 
really need to.

Note:
Though I show these two methods 
for adding styles, there are many 
other methods including the old 

Cut-n-Paste technique ( from one drawing to another ).
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Style Manager - Style Viewer and List

If you select an Object Style in the left pane, as illustrated to the 
right, you should see an Object Viewer in the right pane.  You 
should also find a List tab where you can see a quick overview of 
the Object Style's specifications.

These two options are not for making changes but rather to help 
you go through a huge list to find the best Style for use in your 
project.  This becomes more useful when there are numerous 
Styles with similar names.

Since the Object Viewer uses the 3D Orbit commands, remember 
that you can use the right-click on your mouse to activate a pop-up 
menu to get the same list of options provided on the Viewer toolbar.

Note:
For best results, I highly recommend that you see the left pane as a 
navigation tool much like Explorer's left pane and the right pane as 
the place to actually interact with the styles.  Working with this 
concept should provide more consistent results.

Style Manager - Style Properties - Unique

Most Objects have a variety of tabs following the General tab on 
the Object Style Properties dialog ( see image above, right ).  For 
Door and Widow Styles, you will find the Dimensions tab , Design 
Rules tab and Standard Sizes tab  as common options but the set 
of tabs will vary from Object Style to Object Style.   Generally, 
however, this is where you will find the options to set sizes, shapes 
and some behavioral options.

Read the Parts related the the Object Style for more in-depth 
information about these tabs.

Style Manager - Style Properties  - Common

Materials - for the full story on this topic.Links
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Classifications  - for the full story on this topic.

Display Properties  - for the full story on this topic.

Among the numerous objects in Architectural Desktop, some of the 
common Style Properties include Materials, Classifications and 
Display Properties  and these can be accessed by the tabs 
illustrated to the right.  For information relating to other properties or 
for greater detailed explanations about the properties of a particular 
object, see the Parts and Sections that discuss these objects in 
detail.

For those who have upgraded from Architectural Desktop 3 - 3.3, 
the Materials and Classifications Properties are new to ADT 4 and 
offer even more options for controlling the display of objects.

Materials - this tab provides access to a new way to control and 
manage some of the display properties of Object Styles ( and 
individual objects via style overrides ).  The primary purpose for this 
new property is to allow for material mapping to the objects so the 
process of rendering becomes less time consuming.  In the past, 
since there was no direct way of associating materials with objects, 
mapping of materials had to be done as a separate task through 
direct attachment or via color index numbers.

Classifications - this tab provides access to a new way of adding 
categorization to objects.  The primary purpose of this new property 
is to allow for object grouping regardless of the style or object family 
thus providing a means to classify objects as being part of a 
construction phase or construction type.  Classification can play an 
important role in schedule data but can also be used as an On/Off 
display switch.

Display Properties - this tab provides access to the Display 
Representations for a particular Object Family and offers the option 
to Override the default Display Representation Properties.  Though 
this property is not new to ADT 4 but has been reorganized for 
better clarity.

For a more complete discussion of these three tabs, see the three 
sections below.

6-1 AEC SETUP - DISPLAY

6Object Style Properties - Materials Overview
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Why Overrides?
The reason overrides are necessary in most cases is because of the nature 
of the solution; a very poor one in my opinion.  To offer users more flexibility 
on Materials ( mostly for rendering purposes ) the developers of this software 
created a new object type and allowed it to be embedded within other object 
styles as a unique display property.  The problem with this solution is that you 
are working with one object style and one object style can only have one 
display representation at a time so when you want to assign a Material 
Definition Style, you have to Override its Display Representation in order to 
get anything other than the default.  What this means is that you are always 
using Overrides on Material Definitions which, in turn, means that there is 
really no reason to have more than one Material Definition Style except that 
you will need them to keep track of your Overrides.  In other words, you 
create a Material Definition Style just so you have something to Override.

Object Style Properties - Material Tab

Material StylesLinks

The Materials tab can be 
found on the Style Properties 
dialog box  for most of the 
objects in Architectural 
Desktop.  You can access this 
dialog box by activating the Style 
Manager or by using the Edit 
[Object Name] Style... menu 
option on the object specific 
pop-up menu.

In short, a Material is basically 
how an object looks or "displays" 
on the surface in Plan, 
Elevation, Section, 3D, when 
Rendered and so on.  Materials 
are stored under the Style 
Manager as Material Definition 
Objects and they have their own 
Display Representations stored 
under the Display Manager.

To best explain the use of and 
options for Materials, I have 
chosen to use a custom Door 
Style but this concept applies to 
most of the objects in ADT.

Illustrated to the left is a custom 
door style that I created using a 
Pline that was turned into a 
custom Profile Definition and 

then applied to a unique Door Style Name. Since my example 
object is a Door Style, the Component list under the Materials tab 
of the Door Style Properties dialog box  shows the Components 
that apply to Doors.  If this were a Wall or Window object style, the 
Components would reflect either of those objects.

A unique Material Definition  can be applied to each of the 
Components listed on the Materials tab.  Depending upon the 
drawing file you are working in, there may already be some default 
Material Definitions to choose from ( such as "Doors & 
Windows.Wood Doors.Ash" ) or you can use the Add New 
Material button to create a new Material Definition Style - illustrated 
to the right as "Custom Material". 

To Modify a Material Definition Style , you can double-pick on a 
Component name.  When you create a new Material Definition Style 
from the Material tab, you are automatically taken to the Material 
Definition Properties dialog box  - as illustrated to the right.

Since a Material Definition is actually an Object Style, you will find 
that the Display Properties tab offers Display Representations just 
like those for most objects. Again, the number of Display 
Representations will vary depending upon the current file you are 
working in or the ADT Template file you started with.   Generally, 
you would probably want one Display Representation for each of the 
Display Configurations that you use in a drawing so you can create 
individual object style Overrides for each of these Display 
Configurations.  This logic may not make sense yet so read on and 
it may start to make sense.  Also, keep in mind that this is the first 
attempt at adding surface materials in ADT and some programmers 
have admitted that it is not a fully refined process.

Material Definition Properties

Format> Material Definitions...Menu
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AecMaterialDefine or MaterialDefineKeyboard

Illustrated to the right I show that I have accessed the Material 
Definition Properties dialog for the new custom material definition 
style that I created in the previous step.  Since Material Definition 
Styles belong to one family of objects, the list of Display 
Representations will be the same for all of the Material Definition 
Styles in this drawing file.  And because one object family cannot 
have independent Display Representations ( but must share the 

same set ), these are thus the 
same for all of the material 
assignments you might want to 
make in one drawing file. This 
means that you only have one 
Display Representation to work 
with for all of the possible 
material assignments you might 
want to create and use for 
any Object Style Family ( like 
Doors ).  To work around this 
amazing limitation, you employ a 
Style Override on the Display 
Representation of the current 
Material Definition to provide the 
means for having a unique 
material.  If you don't employ a 
Style Override, you will be 
changing the material for all 
objects using this Material 
Definition Style ( those that don't 
have overrides, that is ).

On the Display Properties tab  
of the Material Definition 
Properties dialog , illustrated 
upper right, I have checked the 
Style Override box for the 
"General Medium Detail" Display 
Representation because that is 
the Display Representation I 
created a new material for in the 
previous step.   Once you place 

a checkmark in a Style Override box, the Display Properties dialog 
box will pop up allowing you to set the overrides.

Once on the Display Properties dialog for a Display Representation 
of a Material Definition, you can see a list of Display Components  
that are relatively universal in application for all objects.  Among the 
list you should see the " Surface Hatch" which is the Display 
Component I have chosen to demonstrate here.  

Illustrated to the right I show that I have turned the Surface Hatch 
Display Component On, Set a unique Color and by picking on the 
Hatching tab, set a unique Hatch Pattern for the Surface Hatch 
Component.

Illustrated to the left I show the results of going through all of this 
work.  Because a Style Override was used, only this Door Style will 
express the Surface Hatch selected in this last step.  If neither of 
the two Style Overrides had been used, all objects would now 
express this Surface Hatch whenever the "General Medium Detail" 
Display Representation for this Material Definition Style is part of 
the current Display Configuration for objects.
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Live Section Rendering
Cut Surface Render Material - use this drop-down list to select any of the  
materials available in the current 
drawing or use the Browse... 
button to search for any raster 
image that you wish to use across 
the surface of a 3D or "Live" 
Sectioned Surface.  In the case of 
a Brick Wall, for example, you 
can have a brick image running 
across a sectioned surface of the 
brick wall or, as the default, a 
simple gray color.

Sectioned Body Render 
Material - use this drop-down list 
and Browse... button as per the 
Cut Surface Render Material.   
Sectioned Body Render Material 
is for a unique option to show 
objects or bodies outside the 
cutting plane.  The default 
material, as per screen capture to the right, uses a translucent blue material 
which is very appropriate to help see what it included and excluded from the 
Live Section.  To see this effect, make sure to Toggle Sectioned Body 
Display  - select section object, right-click to see pop-up menu with this 
option.  Comment: add link to section part when ready

2D Section Rules
Exclude from 2D Section Shrinkwrap - use this checkbox to declare this 
material excluded from automatic 2D Section Shrinkwrapping.  In other 
words, if you are assigning this material to a component of an object but don't 
want the component this material is being assigned to to appear as one 
homogenous material in a 2D Section, then use this checkbox.  The typical 
example of this scenario is the glass in Doors and Windows where you may 
want the glass as a simple set of lines, no hatch, but want frames, jambs and 
other components to appear as one solid shade of gray. Comment: link to part 
for sections when done.

Material Definition Properties - Surface Rendering Materials

Options - System tab - 3D Graphics System 
Configuration - for information on how to control the 
display of rendering materials while in shademode.

Links

xxx Presentation eGuide - for how to create, load and 
use custom materials

By continuing from the 
discussion above, you will find 
more options for material control 
on the "Other" tab of the 
Display Properties dialog box , 
illustrated to the right.  For the 
Surface Hatch, as discussed 
above, you will find the Surface 
Hatch Placement  checkboxes 
that control the planar direction 
for the surface hatch patterns: 
Top, Left, Front, Bottom, Right 
and Back.  By selecting one or 
more of these directions, you 
control how the surface hatch is 
mapped along the surface of the 
object(s) it is applied to.  To 
reduce the drain on your graphics 
card, for example, you probably 
don't need to have surface 
hatches on the Top or Bottom of 
Doors.

Surface Rendering  is similar to 
the concept of Surface Hatch 
but uses a raster image instead 
of a hatch pattern.  This is where 
you assign the photo-realistic 
materials that Viz Render will 
use to create high quality 
presentation images.

Render Material - use this drop-down list to select any of the 
materials available in the current drawing or use the Browse... 
button to search for any raster material available on your entire 
office network.

Mapping - use this drop-down list to select one of three mapping 
options that control how the material is placed or mapped to the 
surface of objects.  Face Mapping is most likely your best choice 
since it places the material on all faces.  The  Same as Surface  
Hatch option will apply the material on those faces checked under 
Surface Hatch Placement and may be a good choice if you don't 
want the material on both sides of an object.  Default Mapping  is 
most likely your least desirable option because it tends to map a 
material acoss the top surface only while bleeding it along the 
edges.

Comment: Expand in the future

7-1 AEC SETUP - DISPLAY

7Object Style Properties - Classifications Overview

Object Classification Definitions
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Format> Classification Definitions...Menu

AecClassificationDefinition or ClassificationDefineKeyboard

Links

Object Style Classifications  are really more about tracking and 
coordinating data related to the objects ( schedules, for example) 
than a matter of Display options but I have included this topic here 
because they can be used to affect the display characteristics of 
objects.

Illustrated to the right I show the two primary dialog interfaces you 
will need to use in order to create and manage Object Style 
Classifications.  Though you will see the option to "Classify" any 
object on the Classifications tab of most Object Style Properties 
dialog boxes, you cannot classify the object style if there are no 
Classification Definitions  for that particular object.

To create a Classification Definition, you will need to use the Style 
Manager (AecStyleManager) to create a New Style Definition 
Name and then Add the Classifications  it.  On the  Style Manager 
dialog, illustrated middle right, I show that I have created a New 
Classification Definition Name  by selecting the Classification 
Definitions category under the Multi-Purpose Objects folder .  By 
editing the new Classification Definition that I named "Construction 
Type", I show that I used the Add button on the Classifications tab 
of the Classifications Definition Properties dialog to Add three 
classification names: "Existing", "Proposed" and "Demolish".  After 
adding these names that I just made up on-the-fly, I show that I 
used the Applies To tab of the same dialog box to Check those 
Object Styles that I want my new Classifications to be available 
for.  Though I show that I have only Applied my new Classifications 
to the Door Styles, it would seem far more logical to Apply to All 
Styles.  Applying to the Classifications to all object styles does not 
mean that they are active but simply available if desired.

Once you have created one or more Classification Definitions within 
the Style Manager Window and used the Applies To tab for the 
object styles you want to use them for, you will now find them 
available on the Classification tab of the Object Style Properties 
dialog ( for those objects that you have applied them to, that is ) - 
see upper right illustration.

Object Classification as a Display Control

As stated above, the reason Object Style Classifications have been 
presented under the Display portion of this guide is that they can be 
used to control object display.   Illustrated to the right I show the 
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Something to think about:
Since Classifications are currently bound to Object Styles, you may want to 
create a generic set of object styles for work to be demolished.  After putting 
together good as-builts, change objects to be demolished to these generic 
styles and thereby acquire not only the proper display characteristics but also 
the classification .

Display Manager Window  where I have selected the Plan 
Display Representation Set in the left pane in order to access the 
Display Options tab  in the right pane.  On the Display Options tab, 
you should see the Classification Definitions you have created and 
for each Definition you should find that you can use the Filter cell 
to set the display to either Show or Hide.

The consequences of this option is that you could, for example, 
create a plan of a proposed remodel where all objects have been 
classified as either Existing, Proposed or Demolish and set to 
Show or Hide depending upon the Display Representation Set and 
Display Configuration used in the drawing.  In other words, you can 
use this option to have a very fast solution for what we have been 
using Layer Filters for: Hide all objects to be Demolished, for 
example.

Okay, before you get too excited about this feature in ADT, keep in 
mind that none of this has been built in so you will have to do all of 
the work in your template file including classifying all of your objects 
and creating unique Display Representation Sets and 
Configurations that take advantage of the Show/Hide Filter for your 
new Classifications.  I state this not to discourage you but only to 
warn you about the work involved.  Also, to fully take advantage of 
this feature you will need a lot of redundant object styles because 
you cannot classify objects individually; i.e., a simple single hinged 
door will need to have three styles - one for each classification ( 
now multiply that by all your objects ).

Classification Definitions are not limited to the scenario I proposed 
here so you may find other opportunities to use them; especially as 
they apply to schedules rather than display.

Classification Definitions will be discussed further under Schedules 
and anywhere else they may affect your work.

Comment: Expand in the future

8-1 AEC SETUP - DISPLAY

8Object Style Display Properties  Overview
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The path you choose to get to the Display Representations is not as 
important as how you work with those Display Representation Settings.  If 
you decide, for example, that you want that custom exterior door with 
thresholds in Plan View you will need to use a Display Representation 
Override.  Since the Display Manager handles the default settings for all 
objects and not the individual Styles, you cannot use this tool to set 
Overrides; instead, you will need to use the other two paths discussed above 
( 2 or 3 ).  And, once you have placed a Display Representation Override on 
an individual object or object style, it will no longer be controlled by the default 
settings as governed by the Display Manager ( hence the term "override" ).

Accessing Object Display Controls

Format> Style Manager...Menu

Format> Display Manager...

AecStyleManagerKeyboard

Select Object, right-click, select Edit Object 
Display...

Mouse

Openings - for more information on DoorsLinks

One of the more difficult concepts to master in ADT has to do with 
how objects change their appearance when viewed from various 
directions and at various levels of detail.  One of the best ways to 
begin the process of mastering this topic is to start with one simple 
object and break the display system down step by step.

If you recall from an earlier discussion about Display Management, 
you will remember that eventually you get down to the display of 
individual object families under the Representations by Object 
folder in the Display Manager Window (Illustrated upper right ).  
This is where you will find all of the Display Representations that 
control how object families appear from different views and at 
different levels of detail; most objects, for example, have a Plan 
Display Representation for how they will look in Plan View.  Since 
architects often desire more or less detail in Plan Views, many 
objects have Display Representations for such needs and you can 
even create your own Plan Display Representations.  Because ADT 
uses 3D objects, most have Display Representations for Model, 
Elevation and so forth where their appearance may be quite 
different than in other Display Representations.

Illustrated to the right I show three different ways that a you can 
access the Display Representations for one particular object family; 
a Door.   The steps are the same for most other ADT objects.  

1) If you open the Display Manager Window , you can access the 
Display Representations for various object families under the 
Representation by Object folder .  

2) If you open the Style Manager Window , you can access the 
primary object families under the Architectural Objects folder 
where you can Edit a single Object Style to gain access to the 
Display Properties.  These object style Display Properties, found on 
the Display Properties tab of the Object Style Properties dialog are 
the very same Display Representations found within the Display 
Manager Window.

3) The last way that you can access the Display Representations 
for objects in ADT is to work with one or more objects that reside in 
your drawing file.  Illustrated to the right I show the object-specific 
pop-up menu for a single door object and the two options that will 
take you directly to the Display Representations for that Object 
Style: Edit Object Display... and Edit [Object Name]  Style... ( in 
this example the [Object Name] is Door.
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Object Display Representations and their Display Properties

Once you have isolated an Object Family  under the 
Representation by Object folder in the Display Manager 
Window, you should find a list of Display Representations .  Each 
Display Representation has its own Display Properties  that always 
include a list of Display Components .  Therefore, for each Display 
Representation you can adjust the Display Components to produce 
different results as they relate to the following properties: On, Off, 
By Material , Layer, Color , Linetype, Lineweight, Lt Scale and 
Plot Style.

Usually the Display Properties dialog will also offer Other options 
and settings on tabs labeled Hatching, Cut Plane, Other and so on.

You can access the Display Representations for Object Families 
through the Display Manager Window as illustrated to the right or 
through individual Object Styles, also illustrated to the right.  As 
long as there are no Style Overrides for the Display Properties of an 
Object Style, the settings found via the Style Manager Window will 
be the same as those found through the Object Style Properties.   
However, Object Styles often have Style Overrides on the Display 
Properties because that is how they differ in your drawings; e.g. this 
is often how an Exterior Door Style shows a Threshold while an 
Interior Door Style does not - without an override both would have to 
show a threshold or neither would show one since there is only one 
Plan Display Representation to share.
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Tracing Object Display Properties back to the Display 
Configurations

Illustrated to the right I show a road map of the relationship between 
one Object Family's Plan Display Representation, the Display 
Representation Sets that use it and the Display Configurations that 
use the Sets so you can toggle this information by a simple pick on 
you screen.

Starting from the example object, a Door, it has a predefined 
Display Representation called " Plan" that you cannot rename or 
delete.  This "Plan" Display Representation is used in the Display 
Representation Set called "Plan" - yes, they created a set that 
uses the exact same name as a Display Representation just to 
confuse you.  Think of this as the Plan Set to keep it clear.  The 
Plan Display Representation Set includes other the Plan Display 
Representations for other objects; hence the term Set.  The Plan 
Display Representation Set is used by at least one Display 
Configuration ; I show one called " Medium Detail " and another 
one called "Standard".  For both of these Display Configurations, 
the Plan Display Representation Set has been assigned to the Top 
View so they appear when you view your drawing from the Top and 
not from the Bottom, Side or 3D.

Tracing Object Display Property Overrides back to the Display 
Configurations

Object Style Display Overrides offer you the opportunity to change 
the way objects appear within a family for the same Display 
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Representation; like "Plan".  One example of where this is 
particularly useful is with Interior and Exterior Doors as stated 
above; for thresholds.  Another example of where this is rather 
useful is with Walls that need to appear different with respect to 
Color, Material, Lineweight and/or Linetype.  

Since Objects like Doors and Walls belong to Object Families and 
each Family can only use one Display Representation at at time ( 
multiples can be turned on but that tends to create a mess ), unique 
characteristics are created through overrides on the primary Family 
Display Representations.

Illustrated to the right I show the connections between an Object 
Display Override and the rest of the Display System.  It is important 
to recognize what you are actually overriding so you don't get 
unexpected results.  As illustrated by the blue arrow to the right, 
these overrides are always at the object level and never at the 
Display Representation Set or Configuration level since neither of 
these two categories actually work on the objects.  In the case of 
the Door Style, for example, when you Override its Plan Display 
Representation you are overriding it at the object level found under 
the Representations by Object folder in the Display Manager ( lower 
right ).

Object Display Overrides, like the parent Representations, follow a 
linear path to one or more Display Representation Sets which in 
turn may be used within one or more Display Configurations.  If you 
set an Override and don't see the results, make sure that your 
override is on a Display Representation that is actually used as part 
of a Display Representation Set within the current Display 
Configuration you may have set on your screen.

Overrides tend to have a negative connotation and that is actually 
for a good reason so you should do your best to fully understand the 
whole override process and the ramifications down the road in a 
project cycle.  A good rule of thumb is to limit the use of overrides 
without limiting yourself.  The reason overrides can be a problem is 
that they isolate object styles or even single objects from a central 
point of control thus turning the task of making broad changes into 
very time consuming jobs. Suppose, for example, that I create 
several Door Styles and override each one so the Door Panel 
Component has a unique color in Plan View.  Later, on the same 
project, imagine that I now need to screen back all of the Door 
Styles so they simply appear as a light background.  Since each 
Door Style has overrides for the Plan Display Representation, they 
can now only be changed on a style-by-style basis.

Object Display Property Overrides - Object and Style Based
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Object Style Display Overrides offer solutions for altering the way 
objects within a single Family appear but sometimes you may find 
that you want to alter how one object within a Style appears.  To 
continue the Interior and Exterior Door analogy from above, 
suppose you now have thresholds on the Exterior Doors via a Door 
Style Display Representation Override for "Plan" but discover that 
there is one Exterior door that needs one of the threshold lines 
removed.  For cases like this, or in cases where a Door needs to 
have a different angle in plan view, you can use a Display Override 
at the individual object level.

In the illustration to the right I show how you can access the 
Display Properties of objects via the object specific pop-up menu.  
When you select one or more objects of the same Style within the 
same object family, you can use the  Edit [Object Name] Style...  
menu option on the object specific pop-up menu to access the 
Display Properties for the Style.  When you select one ( only one ) 
object, you can use the Edit Object Display...  menu option on the 
object specific pop-up menu to change the current Display 
Representation or Attach an Override for just this one object.

When you use the Edit Object Display... object-specific pop-up 
menu option, you will access the Object Display dialog box as 
illustrated to the right ( middle ).  The Display Properties tab on the 
Object Display dialog will appear identical to the tab of the same 
name on the Object Style Properties dialog ( see comparison, right 
).  If you look at the Display Property Source column and the name 
preceding Override for the Override column ( Object vs. Style ), you 
will quickly see that there is a difference.  If you attach or activate 
an Override on the Display Properties tab on the Object Display 
dialog, you are setting changes for that single object alone.

Objects with this level of Display Overrides cannot be controlled 
from a central point so be careful how far you take this option.  By 
now it should be clear that you have two levels of Object Style 
Display Representation Overrides: one that overrides the default 
object style display representation called a " Style Override" and 
one that overrides both the default and any Style Overrides that 
might already have been applied, called an " Object Override".

9-1 AEC SETUP - DISPLAY

9Display Properties Dialog

Different Display Properties for different Display 
Representations

For each unique Display Representation of an Object , you are 
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likely to find unique Display Properties  as they apply to that 
Representation.  For those Display Representations that are merely 
copies or pointers to a parent Display Representation ( like Model 
High Detail  and Model Low Detail  ), the Display Properties will be 
the same as those for the Parent ( Model ).

The Display Properties available for each Display Representation 
are designed to provide options for Component Properties that 
apply to how that Display Representation is expected to be used.  
In the case of a Model Display Representation, for example, the 
number of Display Components might actually be less than the 
number of Display Components found for a Plan Display 
Representation.  More Components do not necessarily mean more 
parts but may just mean more specific separations in those parts to 
allow for more sophisticated control over the presentation of the 
object.

In the illustration to the right I show the Model and Plan Display 
Representation Properties for a simple Single Hinged Door .  As 
you can see, the Plan Display Representation Properties outnumber 
the Model Display Representation Properties by almost three-fold.  
Architects tend to have more display requirements for how a Door 
Object might look in Plans than in 3D Presentation drawings so that 
is why the list is greater for Plan than Model.

Notice that the Display Properties dialog boxes offer different tabs 
for different Display Representations as well.  In the Door example, 
right, the Model Display Representation offers a Muntins tab for 
glazed inserts.   This tab is not available for the Plan Display 
Representation because muntins are not presented in Plan.  You 
could easily argue that mutins should be shown in a Plan view of a 
highly detailed Door but if you expected to achieve this with ADT, 
you currently would not be able to do this very easily ( it could, of 
course be done with the attachment of a Block or other work-around 
solutions ).

Layer/Color/Linetype tab

When you examine the Display Components  on the Layer/ Color/ 
Linetype tab of the Display Representation Properties dialog 
box, you should find some familiar terms like "Layer", "Color" and 
"Linetype".  This breakdown of linework within an object is very 
similar to how AutoCAD users have used Layers inside Blocks for 
many many years.  Generally, the number of Display Components 
is fixed but if you add your own Blocks via the "Other" tab, you can 
actually introduce new Display Components.

Visible - this is just like turning a Layer On or Off.

By Material - this option defers the remaining properties over to a 
Material Definition as set by the Material tab of an Object Style 
Properties dialog.  Gray boxes cannot use Materials and tend to be 
things that do not display in 3D or are just lines instead of 3D 
objects.

Layer - this option allows you to assign a reference layer to a 
Display Component but it is not an insertion layer so don't confuse 
this with the idea that the component will actually reside on another 
layer.  When objects are inserted, they are keyed to one layer just 
like Blocks but you can use this option to emulate component 
layers.  This means that you can control almost everything about 
the component via a layer but if you Freeze the object's insertion 
layer, the component will disappear as well - see discussion below 
for more.

Color, Linetype and Lineweight - these options can be set to 
specific values, ByBlock or ByLayer. Using the ByBlock setting 
offers users the greatest flexibility for changing these properties at 
a later date.   This is what allows you to change an object's Color, 
Linetype or Lineweight in a drawing without having to work with the 
Display Component Properties.  If you set a Color, for example, 
this becomes a static or fixed property that can only be changed 
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here.

Lt Scale - this option is only significant if the display components 
use linetypes.  In AutoCAD and ADT, there are two primary linetype 
scale settings that also have an impact on this setting: Ltscale and 
PsLtscale.   If you change this value to other than "1" then 
whatever the Ltscale value is, you will get a product of the two; 
e.g., setting this to .5 and having your Ltscale set to .25 will 
produce a linetype that is 1/2 of what it looks like at .25 - which 
would be like setting it to .125.

Plot Style  - see comments for Color, Linetype and Lineweight.  
ByBlock is usually the best setting here.

Display Properties -  Deferring Properties to a Layer

At times you may find that you want to change the default Display 
Component Properties to work in a way that is either more flexible 
for you or just produces different results.  One technique for 
externalizing the Display Component Properties is to set a 
component's Layer assignment to a physical layer and then 
deferring the remaining properties to "ByLayer".  The end results of 
this effort is that you will be able to control the internal Display 
Component Properties through the Layer Manager.

Illustrated to the right I show that I created a layer named 
"A-Door-Swng" before going to the Component Display Properties.  
For the Layer Property of the Swing Display Component ( for a Door 
Object ), I set the new Layer.  For Color, Linetyp and Lineweight, I 
set the property values to "ByLayer" which will then allow me to 
change any of these properties on the Layer Manager dialog under 
the "A-Door-Swing" Layer.  For the last two properties, I kept them 
as Static or Fixed settings just to demonstrate that combinations 
are possible.

For more in-depth information on Object Style Properties, see the 
specific Object(s) you are working with.

10-1 AEC SETUP - DISPLAY

10Customizing and Tricks
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Creating a Model Display Configuration for All View Directions

You may have noticed that the 3D Model Display Representations 
of all objects tend to appear only when you view your drawings from 

Isometric or other 3D 
Views.  At times I have 
found that for various 
reasons, including 
resolving weird 
problems with objects, 
that I need to see all of 
the objects in Model 
from the Top or from 
other direct views like 
Front.  Since none of 
the example ADT 
Template files come 
with a Display 
Configuration that 
provides this option, you 
can quickly create your 
own.

On the Display 
Manager Window, high-light the Display Configuration  that you 
would like to make a Copy of, right-click on your mouse  and 
select the New option on the pop-up menu.   When you have your 
copied Display Configuration, Rename it to something like " Model" 
and change all of the Display Representations for the  View 
Directions to "Model".   That's it, you will now have a new Display 
Configuration to select and it will always show your objects in 3D 
form.

Note:
You can also use other Display Representations like Model High 
Detail or mix them up for different View Directions.

If you are in a hurry, you can also just set the Override View 
Direction and have the Default set to "Model".

Illustrated to the left I show what a Plan or Top View of a floor plan 
might look like with this new Model Display Configuration.  Because 
it displays everything in 3D, you can use it to check for linework 
that might otherwise be hidden by such settings as Cut Planes and 
so forth.
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